How to get Help inside Korg-i File Editor?

Note: Korg-i File Editor documentation assumes that you know how to use a mouse, open a menu, and choose menu and dialog options. To review these techniques, consult the documentation for Windows.

General access

To access on line Help, click Contents on the Help menu.

Online Help contains:

· A description of the important concepts you need to understand in order to use Korg-i File Editor effectively.

· The reference material describing the command set.

Context-sensitive access

To access on line Help for the currently selected dialog box or command, hit F1 key.

To access on line Help for a button, half-click it (i.e. press the left mouse button but do not release it) and hit F1 key.

Notations

Commands and controls names are displayed in Bold Italics.

Clicking underlined words produces a jump to the corresponding topic or definition.

Installation

What You Should Know before You Start

It is assumed that you know how to use WindowsWinTM on a PC, more particularly

· Execute Windows programs and operate within a Windows environment.

· Create and move directories and files among disk directories.

IMPORTANT: Before starting Korg-i File Editor, 

· please read carefully the attached file LICENSE.DOC;

· make backup copies of the SetsDefSet you want to edit.

Hardware and Software requirements

Korg-i File Editor is a 32 bit application, designed to be executed on WindowsWinTM 95/98 or Windows NTWinTM v.4 computer platforms with at least 8 MB available RAM.

Korg-i File Editor puts its temporary files into the directory specified by Windows TEMP environment variable (if this variable is not defined, temporary files are put into the application directory).

Installing Korg-i File Editor MIDI driver

Running the SETUP.EXE file has automatically installed Korg-i File Editor components into the correct locations (see next paragraph). However, if you intend to send data from Korg-i File Editor to a KORGKorgTM i-Series with a “TO HOST” cable, you must ask Windows to install an appropriate MIDI driver. A 32 bit version of the KORG PC I/F MIDI Port driver is included in the KORG_W95 subdirectory of the application directory (see below). Please follow the instructions given in your KORG manuals.

Korg-i File Editor components list

1. The SETUP.EXE program has created an application directory, with default path= C:\Program Files\ixx File Editor\), where ixx is i3, i40 or i30 depending on the instrument family the editor is devoted to. The application directory holds the following files and subdirectories:

·  ixxfiled.exe is the “executable” application program. 

·  Kifiled.hlp is the Help file.

·  Kifiled.cnt is the Help Contents file.

·  ixxprsts.txt contains Names and Categories of the Preset ItemsDefItem.

·  ixxtips.txt contains the text for “Tips of the Day” function.

·  IxxEMPTY is a directory used as a model to create new KORG files SetsDefSet (for the i30 family, the directory is I30EMPTY.SET, according to KORG’s standard).

·  KORG_W95 directory contains 3 MIDI driver files (KORGSMD1.DRV, KORGSMV1.386 and OEMSETUP.INF).

·  LICENSE.DOC contains legal information, instructions for registration etc.

· regsoft.exe (with regsoft.cfg) allows registration of the program.

·  ST5UNST.LOG contains installation history.

2. The SETUP.EXE program has created a program Group in the Startup menu, with 2 shortcut icons: ixx File  Editor and Ki FilEd Help.

3. The SETUP.EXE program has installed several standard libraries into the \WINDOWS\SYSTEM directory (Windows 95 or 98) or \WINDOWS\SYSTEM32 directory (Windows NT4): MSVBVM50.DLL, VB5FR.DLL, COMCT232.OCX, COMCTL32.OCX, COMDLG32.OCX, MSFLXGRD.OCX, and TABCTL32.OCX.

Important note: None of the above files/directories should be deleted, moved or renamed.

Uninstalling Korg-i File Editor
To uninstall Korg-i File Editor, don’t remove the files/directories by hand! Let Windows standard Uninstall facility perform this task (Control Panel/Software).

Updating Korg-i File Editor
Future releases of Korg-i File Editor will not need to reload all the libraries. In most cases, replacing ixxfiled.exe should be enough.

Note: New releases or new versions of Korg-i File Editor will be announced and available on the author’s Website:

http://alain.fraysse.free.fr

If you have problems with installation that can’t be solved with this documentation, please email the author Alain Fraysse at

alain.fraysse@free.fr
What is Korg-i File Editor?

Korg-i File Editor helps a KORGKorgTM i-Series IMWDefIMW User organize his or her ArrangementsDefArr, StylesDefSty and ProgramsDefPrg inside standard KORG i-Series file SetsDefSet.

Korg-i File Editor comes in 3 versions:

· i3 File Editor is devoted to KORG i-Series IMW with Product Id = 39H, including i2, i3, i4S.

· i40 File Editor is devoted to KORG i-Series IMW with Product Id = 4DH, including iS35, iS40, iS50, iS50B, i40M.

· i30 File Editor is devoted to KORG i-Series IMW with Product Id = 49H, including i30.

Note: KORG is a trademark of KORG INC.

Main features

·  Delete, Copy/Paste or Move ArrangementsIDH_EditBnkArr, StylesIDH_EditBnkSty and ProgramsIDH_EditBnkPrg inside or between any number of standard KORG i-Series files.

·  Check/fix consistency of LinksDefLink between ItemsDefItem (including Backing SequencesDefBsq, and possibly SongsDefSng and KBD SetsDefArk) inside the currently edited files SetDefSet.

·  Display, print or save to text file a Report that lists all Items of a Set and their mutual links.

·  Edit Arrangements, Styles, Programs, Backing Sequences etc. Names and some other parameters, including GlobalDefGbl and Arrangement GlobalDefArg parameters.

· (i30 and i40 families only) Upload edited files to the KORG i-Series instrument via the serial MIDI IN/OUT link or (if available) the TO HOST interface.

Limitations

·  Korg-i File Editor is not a full Librarian/EditorDefLib: e.g. it is not intended to edit Program parameters or Style patterns (some specialized applications exist for those tasks).

· Each version of Korg-i File Editor works exclusively with KORG i-Series models that recognize its file format (see above).

· Korg-i File Editor has no format conversion facility between different KORG i-Series families (see below).

· Models with other Product Id (e.g. i4S, i5, i5M, iX300) are not supported, but some utilities exist that convert their files (partially when the number of banks is different) to i3 format, which they can load (e.g. Günter Nagler’s utilities on http://www2.iicm.edu/korgprog).

· Harmony files (iS35, iS50B, i40M) are ignored.

Background

Korg-i File Editor  was created to help the author customize 48 StylesDefSty disk files for his KORG i30, i.e.:

· Pick up Styles, scattered among many disk files, on a one-by-one basis, then

· Group them into one big file (48 User Styles), which can be loaded with a single Load command into the i30.

This operation can be achieved on the i30 itself, indeed, but please look below at the required sequence:

The Toaster Ceremony

· Insert the source floppy disk. Press DISK button.

· Select a SetDefSet directory. Touch Open.

· Select a Style file. Touch Open.

· Select the Block. Touch Open.

· Select the Style. Touch File. Touch Load.

· Select internal Style. Touch OK.

· Repeat above steps for the Arrangement(s) that call the Style.

· Repeat above steps for all Styles and Arrangements you want to copy from the source disk.

· Save all Styles and Arrangements into the destination disk.

· Repeat the whole process with other source disks.

On other KORG i-Series models, the sequence is slightly different but just as much complicated. And that’s only a small part of the game…

The Links Nightmare

The big problem concerns all i-Series models, including those with only 4 User Styles memory:

Each time you change, delete or move an ItemDefItem, particularly a ProgramDefPrg, you can affect its behavior as well as the behavior of Items that are linked to it. For example, in an i30 SetDefSet
· each ArrangementDefArr calls 1 Style and 9 Programs,

· each StyleDefSty calls 6 Programs,

· each Backing SequenceDefBsq calls 1 Arrangement, 1 Style and up to 8 Programs (not to mention internal changes!),

· each SongDefSng calls up to 16 Programs (not to mention internal changes!),

· each KBD SetDefArk calls 5 Programs.

As a matter of fact, they don't call them by Names, such as Color Pad or SoulRock 3, but by Reference to their location in memory, such as D57 or U42, without any knowledge of what Programs, Styles etc. have actually been loaded into these locations.

Checking and fixing all existing links turns to a dreadful task entirely left to the User, as we can infer from the simple example below.

An Example (KORG i30)

Note: With a few obvious changes, this example is applicable to i3 and i40 families.

Suppose we are editing a Set of Arrangements, Styles, Programs etc. files in a directory named MYNEWSET.SET. We want to replace Style C42 Latin Pop 3 with Style C13 Acid Funk extracted from a Set in MYOLDSET.SET directory.

· Naturally, using Load a Style command on our instrument, we load Style Acid Funk into C42 location, then we Save Style Block 4 into MYNEWSET.STY.

· Likewise, we copy Arrangement C16 Funkacid (which uses Style C13 Acid Funk in MYOLDSET.STY) into D85 location, then we Save Arrangements into MYNEWSET.

Correct? No, because

· In MYOLDSET.SET, Style Acid Funk, as well as Arrangement Funkacid, call Drum Kit R57 Acid Drum. But in MYNEWSET.PRG, they will find R57 Street Drum instead.

· They also expect to find Program Acid Slap for Bass track in G77, instead of present MYNEWSET.PRG Program Tuba 4.

· In MYNEWSET.SET, Arrangement D85 Funkacid still calls Style at C13, whereas it should call Style Acid Funk at location C42.

Of course, we can copy Acid Drum into R57 and Acid Slap into G77, but this will overwrite Street Drum and Tuba 4, which may be used elsewhere in MYNEWSET Arrangements, Styles, Backing Sequences, Songs and KBD Sets.

To solve the problem, we must check out all Programs called by all MYNEWSET Arrangements, Styles, Backing Sequences etc. before attempting to overwrite any of them. The same holds for Styles etc.

In our example, browsing MYNEWSET.SET shows that:

· Overwritten Style Latin Pop 03 at C42 was nowhere called in the original Set MYNEWSET.

· Street Drum is nowhere called.

· Tuba 4 is only called by Arrangement D61 FlonFlon (track ACC2).

So, we “just” have to

· choose a replacement for Program Tuba 4 in Arrangement D61,

· fix the reference to Style C42 Acid Jazz 2 in Arrangement D85,

· take Aspirin,

· repeat the whole sequence to change or move other Styles.

Hard to follow, isn't it? QED!

If this task is undertaken on the instrument, it soon becomes a nightmare, with dozens of disk inserts and ejects, pressing buttons hundred times etc., and, as a probable result, severe errors.

Specifications

Computer Aided Synchronization

A major function of a KORG i-Series LibrarianDefLib should be assisting the User in preserving the LinksDefLink between relocated ItemsDefItem which belong to the same SetDefSet.

Note that this “synchronization” cannot be fully automatic because of instrument memory limitations. If, for example, each User Styles is called by a User Arrangements, any Style addition implies giving up an existing Style and, consequently, the Arrangements that call it too.

So, whatever the method used to customize a Set, the User will at least be in charge of

· choosing the Programs,

· telling each Arrangement, Style, Backing Sequence (and possibly Song and KBD Set) which Program to call for each of their tracks (Drum, Perc, Bass, etc.),

· telling each Backing Sequence which Arrangement and which Style to use,

· telling each Arrangement which Style to use.

As a complement to editing commands, such a Librarian should give the User all information needed to achieve the above goals, either on the screen, in printed form or editable file form.

Individual Editing

Individual editing of ItemsDefItem can be limited to Names and a few parameters, at least to alleviate the most painful operations mentioned above.

Links between Items in a Set

Inside a Set

· each ArrangementDefArr calls 1 StyleDefSty and 11 ProgramsDefPrg,

· each StyleDefSty calls 6 ProgramsDefPrg,

· each Backing SequenceDefBsq calls 1 ArrangementDefArr, 1 StyleDefSty and 8 ProgramsDefPrg (and possibly more if changes are used inside the sequence),

· (i3 and i30 families only) each SongDefSng calls up to 16 ProgramsDefPrg (and possibly more if changes are used inside the SequenceDefSeq),

· (i40 and i30 families only) each KBD SetDefArk calls 5 ProgramsDefPrg.

Set Integrity

The main interest of Korg-i File Editor being to synchroniseSpec ArrangementsDefArr, StylesDefSty, ProgramsDefPrg, Backing SequencesDefBsq (and possibly SongsDefSng and KBD SetsDefArk) inside KORG i-Series files SetsDefSet, Korg-i File Editor cannot work with an incomplete Set.

So, even if you’re not concerned by synchronization and want to edit some of the files independently from each other, all files must be present in the same Set directory before Korg-i File Editor can work on it.

If a file is missing, you can copy any valid KORG file with the missing extension into the Set directory and rename it with the Generic NameDefGenNam of the Set.

But don’t worry: if, when trying to open a SetIDH_OpenSet, Korg-i File Editor finds that one or more files are missing, it will propose to create them for you, by duplicating file(s) extracted from the Empty SetDefEmpty present in the same directory as Korg-i File Editor program.

Calls Redirection

Automatic links checking (all Items)

Whatever the edited ItemDefItem, Korg-i File Editor checks if linked Items are affected by the editing process and prompts the User for a decision:

· Abort the editing operation.

· Replace with another Item and continue.

· Don’t replace and continue.

For example (i30 family), before replacing the Program D12 Old Piano in DEST.SET by D14 New Piano taken from SOURCE.SET, Korg-i File Editor scans all the Arrangements, Styles, Backing Sequences, Songs and KBD Sets in DEST.SET to find which of them call Program D12. If some are found, all their calls to D12 can be redirected to another Program, such as A11, or D14 of course!

Redirection Command (Programs only)

In addition, a single command allows redirecting all calls for a given Program (Preset or User) to another Program (see Editing Parameters of a ProgramIDH_EditParPrg).

For example, in I30PLOAD.SET, the User can decide that all Items that called A15 E.Piano 1 must call F25 i30 Whirly from now on.

Planning an Editing Session

Although Korg-i File Editor was designed to prevent the User from breaking links between linked ItemsDefItem, numerous “trial and abort” operations can be avoided by following a logical process, briefly suggested hereunder.

From within Korg-i File Editor, open the Destination SetDefDest and, if necessary, Source Set(s)DefSrce. With paper and pencil, make a sketch of the Items you want to edit (i.e. modify, copy, paste etc.). The “Links” or “Calls” display of Items editing windows in Korg-i File Editor will considerably help, as well as the ReportDefRep features.

· In Program Mode, install into User BanksDefBnk all the User ProgramsDefPrg needed by your StylesDefSty, your ArrangementsDefArr, your Backing SequencesDefBsq and (possibly) your SongsDefSng.

· In Style Mode, install the Styles in any order. The only constraint is that the total size of each BlockDefBlk cannot exceed 15200 EventsDefEvt.If a Style is too “big” to fit in available room in the destination Block, Korg-i File Editor of course warns you.

· In Arrangement Mode, install the Arrangements, in any order but at logical locations.

· If necessary, edit individual Items and/or common parameters.

Backing Sequences, Songs and KBD Sets can be moved and edited as wellFAQ.

Note: Remember that as soon as you openIDH_OpenSet any KORG SetDefSet, either as Destination SetDefDest or as Source SetDefSrce, Korg-i File Editor checks that 5 (i3 family), 7 (i40 family) or 8 (i30 family) valid files exist with the same Generic NameDefGenNam and respective extensions .ARR, .BSQ, .PCG, .SNG, .STY (i3 family), .ARG .ARR, .BSQ, .GBL, .KBS, .PRG, .STY (i40 family), .ARG, .ARK, .ARR, .BSQ, .GBL, .PRG, .SNG, .STY (i30 family).
If the Set is incomplete, Korg-i File Editor proposes to create the missing files.

Editing Session Example

Note 1: The User is assumed to know the differences between an ArrangementDefArr, a StyleDefSty, a ProgramDefPrg, a Backing SequenceDefBsq and a SongDefSng (not so obvious for newcomers to KORG i-Series IMWDefIMW!). So we shall focus on Style copying which is the most tedious operation when undertaken on the Korg-i itself.

Note 2: Remember that as soon as you openIDH_OpenSet any KORG SetDefSet, either as Destination SetDefDest or as Source SetDefSrce, Korg-i File Editor checks that 5 valid files (i3 family) or 8 valid files (i40 and i30 families) exist with the same Generic NameDefGenNam and respective extensions .ARR, .BSQ, .PCG, .SNG, .STY (i3 family), .ARG .ARR, .BSQ, .GBL, .KBS, .PRG, .STY (i40 family), .ARG, .ARK, .ARR, .BSQ, .GBL, .PRG, .SNG, .STY (i30 family).
If the Set is incomplete, Korg-i File Editor proposes to create the missing files.

Note 3: Remember also that any Item calls other Items by their ReferencesDefRef, not by their NamesDefNam or semantic content: for example, if for any reason a Style (or a Program) at a given Reference is changed, the Arrangements which call it don’t care! Fortunately, Korg-i File Editor checks all calls to the Item being changed and prompts you for a decision (abort change, or redirect the calls to another designated Item).

Note 4: The example below is for i30, but it can easily be transposed to i3 and i40 families.

In the example we use in BackgroundBackGnd topic, we want to replace, in MYNEWSET.STY, Style C42 Latin Pop 3 by Style C13 Acid Funk extracted from MYOLDSET.STY. How can we achieve this with Korg-i File Editor?

· We open MYNEWSET.SET, then select Style tab (if not already selected).

· We open MYOLDSET.SET (Note that Style tab is already selected).
If both windows overlap, we separate them (either with the mouse or by clicking Tile in the Window menu).

· We drag Style cell C13 Acid Funk from MYOLDSET window and drop it onto cell C42 Latin Pop 3 of MYNEWSET window.
We get message: “Track ‘DRUMS’ of Style ‘Acid Funk’ calls Program ‘Acid Drum’ non-existent in MYNEWSET. Redirect this track to another Program?”

· We click Yes, then select R31 GM Kit 3.
A new message appears: “Track ‘BASS’ of Style ‘Acid Funk’ calls Program ‘Acid Slap’ non-existent in MYNEWSET. Redirect this track to another Program?”

· We click Yes, then select F75 Slap Bass 4.

Of course, if we can’t find, in MYNEWSET, satisfactory Programs as replacements for Acid Drum and/or Acid Slap, we should answer Cancel (which would abort the copying process) and take care of Programs before attempting transferring the Style again.

Note: By double-clicking Style cell C13 Acid Funk, we could have foreseen this potential problem! So, let’s try now to copy Program R57 Acid Drum from MYOLDSET to MYNEWSET:

· We select Programs tabs and R Banks in both Sets windows.

· By looking at Programs grid in the MYNEWSET window, we can immediately see that, although there are no empty cells (not named, dark background), some Drum Kits are not called by any Item (blue inked characters), such as R54 User Kit 4 in our example.
So we just have to drag R57 Acid Drum cell from MYOLDSET and drop it into R54 cell in MYNEWSET.

· We repeat the same process for copying Acid Slap into an unused Program cell in MYNEWSET.

· Now we can resume copying Style C13 Acid Funk (5 first steps above). Korg-i File Editor finds that all Programs called by the copied Style exist somewhere in MYNEWSET and fixes Calls References if necessary.
We can verify the result by double-clicking C42 Acid Funk in MYNEWSET.

Note 1: The safety of the above-described process supposes uniqueness of Item Names. That’s the reason why, all along the editing session, Korg-i File Editor warns the User if it detects duplicate Names in Arrangements, Styles and Programs that belong to an open Set. A good idea is to change the Names of recently pasted Items as soon as possible. However, duplicate detection and warning feature can be disabled in the Options dialog box (see Options menuIDH_mnuOptions).

Note 2: The above-described tasks are even easier with a listing of the initial configuration of each Set involved in the editing process.
See Report Command
Creating a Set

To create a new SetDefSet, choose the New command in the File menu, or press Ctrl + N. The new Set is filled with data copied from the Empty SetDefEmpty files.

Note: All created User Styles are InitialisedDefIniSty.

Opening a Set

To open a SetDefSet, choose the Open command in the File menu, or press Ctrl + O. The dialog window is somewhat different from standard Open dialogs in Windows 95/98, because a Set is a directory rather than a file.

When you double-click a *.SET directory (left frame), Korg-i File Editor checks its contents. If the selected Set is incomplete, Korg-i File Editor proposes to complete it automatically, using the Empty SetDefEmpty files as models.

Note: If Open last Set at Start-up checkbox (accessed via the Options menu) is checked, the last Set used when closing a session is memorized, so that it will open automatically at restart.

Saving a Set

To save a SetDefSet, choose the Save command in the File menu, or press Ctrl + S. The dialog window is somewhat different from standard Open dialogs in Windows 95/98, because a SetDefSet is a directory rather than a file.

If the Set has been saved at least once, Korg-i File Editor saves only its “dirty” filesDefDirty.

If the Set has not yet been saved, Korg-i File Editor asks for a Set Name and saves all data (8 Set filesDefSet).

To force saving all data, choose the Save As command in the File menu.

Saving occurs automatically when a Set window is closed and its data are “dirty”DefDirty.

The Subsets Tabs

Opening a SetIDH_OpenSet initiates a new window attached to this SetDefSet. This window comprises tabs, used to display and edit the various SubsetsDefSubSet of the Set: ArrangementsDefArr, StylesDefSty, ProgramsDefPrg, Backing SeqsDefBsq, and possibly SongsDefSng (i3 and i30 families) and KBD SetsDefArk (i40 and i30 families).

· The ArrangementsIDH_EditBnkArr, StylesIDH_EditBnkSty and ProgramsIDH_EditBnkPrg tabs are almost identical. Each one shows a grid (with a specific background color) that can display the contents of a whole BankDefBnk, i.e. the ReferencesDefRef and NamesDefNam of all the Items inside this Bank. This grid can be edited, i.e. rearranged or modified by copying, deleting, pasting or moving some of its Items. These LibrarianDefLib tasks can involve Items that belong to different open Sets, mainly for copying an Item from a Set to another. Many editing commands found in spreadsheets are available here (CutIDH_mnuECut, CopyIDH_mnuECopy, PasteIDH_mnuEPaste, Drag & Drop MoveMouse, DeleteIDH_mnuEDel, InsertIDH_mnuEIns , Erase bankIDH_mnuEClear and ImportIDH_mnuEImport). The DetailsIDH_mnuEDetails command gives access to individual Item Editing features. The Create Subset Report FileIDH_mnuUSSRep command saves to disk a spreadsheet-ready list of the main characteristics of Items in the Subset. Double-clicking an ItemDefItem opens a window, which displays and allows editing the main control parameters of the selected Item.

· The Backing SequencesIDH_EditParBsq and (i40 and i30 families only) SongsIDH_EditParSng tabs are identical. Each one shows a list that can be edited in a similar manner as described above for Arrangements, Styles and Programs. Available commands are CutIDH_mnuECut, CopyIDH_mnuECopy, PasteIDH_mnuEPaste, Drag & Drop MoveMouse, DeleteIDH_mnuEDel,  InsertIDH_mnuEIns, and DetailsIDH_mnuEDetails. Double-clicking an ItemDefItem opens a window, which displays and allows editing the main control parameters of the selected Item.

· The KBD SetsIDH_EditArk tab (i40 and i30 families only) displays a list that can be edited with the following commands: CopyIDH_mnuECopy, Paste, Erase bank IDH_mnuEPaste, ImportIDH_mnuEImport and Drag & Drop MoveMouse. Double-clicking a cell of the grid allows editing its value.

· The Send to Korg-iIDH_mnuUMidSend menu command uploads (sends) the Subset data to the instrument via the TO HOST interface or a serial MIDI link.

· The Send SysEx to FileIDH_mnuUSysex2File menu command saves the Subset data as a System Exclusive file.

Note 1: (i40 and i30 families only) In Arrangement and Program Mode, checking Twin View doubles the size of the displayed grid, allowing Drag & Drop Move operations between User banks in the same Set.

Note 2: In Arrangement Mode, a button allows editing GlobalIDH_EditGbl parameters. For i40 and i30 families, a second button allows editing Arrangement GlobalIDH_EditArg parameters.

Note 3: When the Set window opens, the default tab is selected according to the last Mode used: e.g., if the previously active Set window was in Style Mode (i.e. tab Styles selected), the new window opens in Style Mode. When the User quits, the Mode used by the last closed window is memorized, so that it will be used for the first opening at next start-up.

Editing an Arrangements Bank

Selecting a Bank

In the Set window, select the Arrangements tabSubsTab.

Any BankDefBnk can be displayed using the Bank selector box, including (not editable) Preset Banks.

Note 1: At opening a SetIDH_OpenSet, the displayed Bank is the first User Bank.

Note 2: (i40 and i30 families only) Checking Twin View doubles the size of the displayed grid, e.g. allowing Drag & Drop Move operations between contiguous Banks in the same Set.

Arrangements Bank grid

Each cell shows:

· the Reference of an Arrangement,

· its Name,

· the Style called (used). Suffix U emphasizes a User style.

If the Highlight called Items option is checked in the Options dialog box (see Options menuIDH_mnuOptions), then a Red text means the Arrangement is called by some Backing Sequence(s), whereas a Blue text means it is nowhere called.

Dimmed text points out Preset Arrangements  (i40 and i30 families only).

Editing the Bank grid

The grid can be rearranged or modified by copying, deleting, pasting or moving some of its Arrangements. These LibrarianDefLib tasks can involve Arrangements that belong to different open Sets, mainly for copying an Arrangement from a Set to another. Many editing commands found in spreadsheets are available here (CutIDH_mnuECut, CopyIDH_mnuECopy, PasteIDH_mnuEPaste, Drag & Drop MoveMouse, DeleteIDH_mnuEDel, InsertIDH_mnuEIns, Erase bankIDH_mnuEClear and ImportIDH_mnuEImport).

In addition, one can paste an Arrangement extracted from an IAF fileDefIsf (see Paste from IStyleIDH_mnuEIStyle command).

All Arrangements data of the current Set can be uploaded to a compatible Korg i-Series IMW or saved to a file with menu commands (see Send to Korg-iIDH_mnuUMidSend and Send SysEx to FileIDH_mnuUSysex2File).

In the i30 version, the current User Arrangements Bank can be exported to a “Restore Preset” file, which can be loaded by the i30 (see Export to Preset FileIDH_mnuUExPreset).

Note: (i40 and i30 families only) Arrangements Erase Bank and Import commands are not available while in Twin View mode.

Warning 1: Arrangements Erase Bank and Import commands cannot be undone!

Warning 2: In the unregistered version, pasting to the second half of each User bank is not available.

Editing Parameters of an Arrangement

The DetailsIDH_mnuEDetails command gives access to Editing the Parameters of an ArrangementIDH_EditParArr.

Global and Arrangement Global Buttons

These buttons open GlobalIDH_EditGbl and Arrangement GlobalIDH_EditArg editing windows (see respective topics).

Editing a Styles Bank

Selecting a Bank

In the Set window, select the Styles tabSubsTab.

Any Bank can be displayed using the Bank selector box, including (not editable) Preset Banks.

Note: At opening a SetIDH_OpenSet, the displayed BankDefBnk is the User Bank.

Styles Bank grid

Each cell shows:

· the Reference of a Style,

· its Name,

· its Size (number of EventsDefEvt used).

If the Highlight called Items option is checked in the Options dialog box (see Options menuIDH_mnuOptions), then a Red text means the Style is called by some other User Arrangement(s) or Backing Sequence(s), whereas a Blue text means it is nowhere called.

Dimmed text points out Preset Styles.

For User Styles, an additional column displays the number of free EventsDefEvt for each row.

Editing the Bank grid

The grid can be rearranged or modified by copying, deleting, pasting or moving some of its Styles. These LibrarianDefLib tasks can involve Styles that belong to different open Sets, mainly for copying a Style from a Set to another.

Many editing commands found in spreadsheets are available here (CutIDH_mnuECut, CopyIDH_mnuECopy, PasteIDH_mnuEPaste, Drag & Drop MoveMouse, Erase bankIDH_mnuEClear and ImportIDH_mnuEImport).

In addition, one can paste a Style extracted from an ISF fileDefIsf (see Paste from IStyleIDH_mnuEIStyle command).

Any Style BlockDefBlk of the current Set can be uploaded to the Korg instrument or saved to a file with menu commands (see Send to Korg-iIDH_mnuUMidSend and Send SysEx to FileIDH_mnuUSysex2File).

Warning 1: Styles Erase Bank and Import commands cannot be undone!

Warning 2: In the unregistered version, pasting to the second half of the User bank is not available.

Editing Control Parameters of a Style

The DetailsIDH_mnuEDetails command gives access to Editing Control Parameters of a StyleIDH_EditParSty.

Editing a Programs Bank

Selecting a Bank

In the Set window, select the Programs tabSubsTab.

Any Bank can be displayed using the Bank selector box, including (not editable) Preset Banks.

Note 1: At opening a SetIDH_OpenSet, the displayed BankDefBnk is the first User Bank (bank F).

Note 2: (i40 and i30 families only) In Arrangement and Program Mode, checking Twin View doubles the size of the displayed grid, allowing Drag & Drop Move operations between contiguous Banks in the same Set.

Programs Bank grid

Each cell shows:

· the Reference of a Program,

· its Name.

If the Highlight called Items option is checked in the Options dialog box (see Options menuIDH_mnuOptions), then a Red text means the Program is called by some other User Item(s) (Arrangements, Styles etc.), whereas a Blue text means it is nowhere called.

Dimmed text points out Preset Programs.

Editing the Bank grid

The grid can be rearranged or modified by copying, deleting, pasting or moving some of its Programs. These LibrarianDefLib tasks can involve Programs that belong to different open Sets, mainly for copying a Program from a Set to another. Many editing commands found in spreadsheets are available here (CutIDH_mnuECut, CopyIDH_mnuECopy, PasteIDH_mnuEPaste, Drag & Drop MoveMouse, DeleteIDH_mnuEDel, InsertIDH_mnuEIns, Erase BankIDH_mnuEClear and ImportIDH_mnuEImport).

In addition, one can paste a Program or DrumKit extracted from an IPF or IDK fileDefIsf (see Paste from IStyleIDH_mnuEIStyle command).

All Programs data of the current Set can be uploaded to a Korg i-Series or saved to a file with menu commands (see Send to Korg-iIDH_mnuUMidSend and Send SysEx to FileIDH_mnuUSysex2File).

In the i30 version, the current User Programs Bank can be exported to a “Restore Preset” file, which can be loaded by the i30 (see Export to Preset FileIDH_mnuUExPreset).

Note 1: (i40 and i30 families only) Programs Erase Bank and Import commands are not available while in Twin View mode.

Note 2: Delete and Insert commands are not available for Drum Kits.

Warning 1: Programs Erase Bank and Import commands cannot be undone!

Warning 2: In the unregistered version, pasting to the second half of each user bank is not available.

Editing Parameters of a Program

The DetailsIDH_mnuEDetails command gives access to Editing Parameters of a ProgramIDH_EditParPrg.

Editing Global

In the Set window, select the Arrangements tabSubsTab, then press the Global button.

The GlobalDefGbl parameters displayed and editable are the pedals and switches assignments, plus Velocity and Aftertouch curves selection :

·  Switches 1 & 2 (i30 family only),

·  Damper Switch Polarity,

·  Assignable Pedals 1 & 2,

·  EC5 Pedal Switches,
· Velocity & Aftertouch curves.

Pressing Import button allows replacing all the Global data of the selected Set with homologous data imported from another Set file.

Warning: the Global Import command cannot be undone!

Pressing Send SysEx to File button saves the Global data as a System Exclusive file (in KORG i-Series format). This file can be uploaded later to the instrument with an appropriate SysEx utility, or an equivalent function included in most sequencers.

Pressing Send to Korg-i button uploads (sends) the Global data to the instrument via the MIDI IN/OUT link or the TO HOST interface (if available on the instrument).

Editing Arrangement Global (i40 and i30 families only)

In the Set window, select the Arrangements tabSubsTab, then press the Arrangement Global button.

Displayed and editable Arrangement GlobalDefArg parameters are as follows (see KORG’s manuals for more detailed descriptions of these parameters).

·  MIDI Channels assigned to the 16 Arrangement tracks.

·  Velocity Control assignment.

·   (i30 family only) Chord Sound settings.

·  Chord Recognition mode.

·  Programmable Control Buttons or functions:
– Chord Memory, Chord Sound, Bass Inversion, Ensemble;
– Tempo Lock, Keyboard Lock, Split Point Lock;
– Synchro Start, Synchro Stop.

The Set All Split Keys box allows changing the Keyboard Split Point for all Arrangements at once. If all Split Points are already the same, the box displays their value on a white background, else it displays default value C4 on a grey background.

Note: Pressing Cancel button cancels all changes, except Set All Split Keys.

Pressing Import button allows replacing all the Arrangement Global data of the selected Set with homologous data imported from another Set file.

Warning: the Arrangement Global Import command cannot be undone!

Pressing Send SysEx to File button saves the Arrangement Global data as a System Exclusive file (in KORG i-Series format). This file can be uploaded later to the instrument with an appropriate SysEx utility, or an equivalent function included in most sequencers.

Pressing Send to Korg-i button uploads (sends) the Arrangement Global data to the instrument via the MIDI IN/OUT link or the TO HOST interface (if available on the instrument).

Editing KBD Sets (i40 and i30 families only)

In the Set window, select the KBD Sets tabSubsTab.

· The KBD SetsDefArk grid can be rearranged or modified by copying, pasting or moving its rows. These LibrarianDefLib tasks can involve KBD Sets that belong to different open Sets, mainly for copying a KBD Set from a Set to another. A few commands are available for that (CopyIDH_mnuECopy, PasteIDH_mnuEPaste, Drag & Drop Move, Erase bank Mouse and ImportIDH_mnuEImport).
For a Drag & Drop Move, drag the KBD Set Reference cell (KS column, in red) you want to move, then drop it onto the cell before which you want to insert. When dragging to another Set, you can avoid automatic scrolling of the source grid by leaving it on the left side rather than top or bottom.

· The KBD Sets individual parameters displayed and editable are:
- the Keyboard Split Point (Sp column, in blue);
- the Programs calledIDH_CalledPrg by the selected KBD Set tracks.
To edit a parameter, double-click it.

· Double-clicking the title of Split Key column allows changing the Keyboard Split Point for all KBD Sets at once.
Warning: This operation cannot be Undone.

All KBD Sets data of the current Set can be uploaded to a Korg i-Series or saved to a file with menu commands (see Send to Korg-iIDH_mnuUMidSend and Send SysEx to FileIDH_mnuUSysex2File).

Warning: the KBD Sets Import command cannot be undone!

Editing a Backing Sequences List

Editing the list

Each line of the list shows:

· the Reference of a Backing Sequence,

· its Name,

· its number of EventsDefEvt.

· The list can be rearranged or modified by copying, deleting, pasting or moving some of its Items. These LibrarianDefLib tasks can involve Backing Sequences that belong to different open Sets, mainly for copying a Backing Sequence from a Set to another. Many editing commands found in spreadsheets are available here (CutIDH_mnuECut, CopyIDH_mnuECopy, PasteIDH_mnuEPaste, Drag & Drop MoveMouse, DeleteIDH_mnuEDel, InsertIDH_mnuEIns, Erase BankIDH_mnuEClear and ImportIDH_mnuEImport). 

Note: Drag & Drop behaves differently than for Arrangements – see , Drag & Drop MoveMouse.

The Events frame summarizes the EventsDefEvt counts of the Set.

Note 1: the i-Series memory is limited to 65536 Events, shared by Backing Sequences,  and (i3 and i30 families) Songs and Song Patterns.

Note 2: Styles have their own Events memory – see Style BlocksDefBlk.

Warning: the Backing Sequences Erase Bank and Import commands cannot be undone!

Editing Parameters of a Backing Sequence

The DetailsIDH_mnuEDetails command gives access to Editing the Parameters of a Backing SequenceIDH_EditParBsq.

Editing a Songs List (i3 and i30 families only)

Editing the list

Each line of the list shows:

· the Reference of a Backing Sequence,

· its Name,

· its number of EventsDefEvt.

The list can be rearranged or modified by copying, deleting, pasting or moving some of its Items. These LibrarianDefLib tasks can involve Songs that belong to different open Sets, mainly for copying a Song from a Set to another. Many editing commands found in spreadsheets are available here (CutIDH_mnuECut, CopyIDH_mnuECopy, PasteIDH_mnuEPaste, Drag & Drop MoveMouse, DeleteIDH_mnuEDel, InsertIDH_mnuEIns, Erase BankIDH_mnuEClear and ImportIDH_mnuEImport).

Note: Drag & Drop behaves differently than for Arrangements – see , Drag & Drop MoveMouse.

The Events frame summarizes the EventsDefEvt counts of the Set.

Note 1: the i-Series memory is limited to 65536 Events, shared by Backing Sequences, Songs and Song Patterns.

Note 2: Styles have their own Events memory – see Style BlocksDefBlk.

Warning: the Songs Erase Bank and Import commands cannot be undone!

Editing Parameters of a Song

The DetailsIDH_mnuEDetails command gives access to Editing the Parameters of a SongIDH_EditParSng.

Editing the Parameters of an Arrangement

Opening an Arrangement

In the Set window, select the Arrangements tabSubsTab, then the BankIDH_EditBnkArr that contains the Arrangement.

In the grid, double-click the Arrangement (you can also use the Details command in the Edit menu or the contextual menu – see Using the MouseMouse).

Editing its Parameters

Displayed and editable parameters are as follows (see KORG’s Manuals for a more detailed description of these parameters).

·  Arrangement: Name and Category.

·  Keyboard: Chord Scan mode, Split Key, Transpose, Full KBD Play.

·  Initial Variations and Variation Change.

·  Ensemble and Tempo.

·  Default Drum Maps.

·  Links:
– Style calledIDH_CalledSty.
– Programs calledIDH_CalledPrg.
– Called by lists the Backing Sequences that call (use) this Arrangement (not editable).

Note: For a Preset Arrangement, only the Name, the Category, the Style Used and the “Called by” list are displayed.

Editing the Control Parameters of a Style

Opening a Style

In the Set window, select the Styles tabSubsTab, then the BankIDH_EditBnkSty that contains the Style.

In the grid, double-click the Style (you can also use the Details command in the Edit menu or the contextual menu – see Using the MouseMouse).

Editing its Parameters

Displayed and editable parameters are as follows (see KORG’s Manuals for a more detailed description of these parameters).

· Style: Name and Category.

· Number of EventsDefEvt used by the Style (not editable).

· Number of EventsDefEvt available in current BlockDefBlk (not editable).

· Links:
– Programs calledIDH_CalledPrg.
– Called by lists the Arrangements and Backing Sequences that call (use) this Style (not editable).

Note: For a Preset Style, only the Name, the Category and the “Called by” list are displayed.

Editing the Parameters of a Program

Opening a Program

In the Set window, select the Programs tabSubsTab, then the BankIDH_EditBnkPrg that contains the Program.

In the grid, double-click the Program (you can also use the Details command in the Edit menu or the contextual menu – see Using the MouseMouse).

Editing its Parameters

Displayed and editable parameters are as follows (see KORG’s Manuals for a more detailed description of these parameters).

· Program: Name and Category.

· Links: Called by lists the Arrangements, Styles, Backing Sequences and possibly Songs and KBD Sets that call (use) this Program (not editable).

Note: For a Preset Program, only the Name and the Category are displayed.

Redirecting calls to another Program
The Call another Program button allows to modify, at once, all Items (Arrangements, Styles, Backing Sequences, Songs and KBD Sets) that call the present Preset or User Program, in order that they call another designated Program. Program selection can be made by Bank or by Category.

Editing the Control Parameters of a Backing Sequence

Opening a Backing Sequence

In the Set window, select the Backing Seq tabSubsTab.

In the list, double-click the Backing Sequence you want to edit.

Editing its Parameters

Displayed and editable parameters are as follows (see KORG’s Manuals for a more detailed description of these parameters).

· Backing Sequence: Name.

· Chaining settings.

· Links:
– Arrangement calledIDH_CalledArr
– Style calledIDH_CalledSty
– Programs calledIDH_CalledPrg.

Editing the Control Parameters of a Song (i3 and i30 families only)

Opening a Song

In the Set window, select the Songs tabSubsTab.

In the list, double-click the Song you want to edit.

Editing its Parameters

Displayed and editable parameters are as follows (see KORG’s Manuals for a more detailed description of these parameters).

· Song: Name.

· Chaining settings.

· Links: Programs calledIDH_CalledPrg.

Using the Mouse

A 2 buttons Mouse can be used in a Windows 95/98 standard fashion to Select, Open or Move ItemsDefItem:

Selecting an Item

Click it with Left Button.

Opening, Displaying or Editing an Item

Double-click it with Left Button.

Contextual Menu for an Item

Click Item with Right Button.

Note: for a KBD Set, click its number in the first column.

Moving an Arrangement, a Style or a Program

Rather than using Cut (or Copy) then Paste commands, it is faster to Drag & DropDefDragDrop the Item:

· If Drag & Drop events occur in the same SetDefSet, the Move operation is equivalent to a Cut & Paste sequence, which clears the Source Item.

· If Drag & Drop events occur in two different Sets, the Move operation is equivalent to a Copy & Paste sequence, which copies the Source Item without clearing it.

Moving a Backing Sequence or a Song

Rather than using Cut (or Copy) then Paste commands, it is faster to Drag & DropDefDragDrop the Item:

· If Drag & Drop events occur in the same SetDefSet, the Move operation is equivalent to a Delete & Insert sequence, which re-arranges the list without clearing any Item.

· If Drag & Drop events occur in two different Sets, the Move operation is equivalent to a Copy & Paste sequence, which copies the Source Item without clearing it.

Note 1: Unlike some other Windows 95/98 applications, Shift, Control and Alt Keys are not used to differentiate the actions performed by a Drag & Drop operation, since the correct action is automatically selected.

Note 2: Of course, dropping is only allowed on an Item with the same type as the dragged Item.

Note 3: During Drag operation, the Mouse cursor changes to a small keyboard icon.

Moving a KBD Set

The KBD SetsDefArk bank can be rearranged, one Item at a time: with the mouse, drag the KBD Set Reference cell (KS column, in red) you want to move, then drop it onto the cell before which you want to insert (see Editing KBD SetsIDH_EditArk).

Hint: When dragging to another Set, you can avoid automatic scrolling of the source grid by leaving it on the left or right side rather than top or bottom.

Menus

The ‘Application’ menu bar

When no Set is open, the menu bar displays 2 menus:

· File MenuIDH_mnuFile
· ? (i.e. Help) MenuIDH_mnuHelp.

The ‘Set’ menu bar

When at least one Set is open, the menu bar displays the menus relevant to the currently selected Set:

· File MenuIDH_mnuFile
· Edit MenuIDH_mnuEdit
· Window MenuIDH_mnuWindow
· Utilities MenuIDH_mnuUtilities
· ? (i.e. Help) MenuIDH_mnuHelp
File Menu

The File dropdown menu holds following commands:

· New CommandIDH_mnuFNew
· Open CommandIDH_mnuFOpen
· Close CommandIDH_mnuFClose
· Save CommandIDH_mnuFSave
· Save As CommandIDH_mnuFSaveAs
· Exit CommandIDH_mnuFExit
New Command

See Creating a SetCreateSet.

Open Command

See Opening a SetIDH_OpenSet.

Close Command

This command closes the Set displayed in the currently active window and save its data if they are “dirty”DefDirty (see Saving a SetIDH_SaveSet).

Save Command

See Saving a SetIDH_SaveSet.

Save As Command

See Saving a SetIDH_SaveSet.

Exit Command

This command closes all open Sets and save their data if they are “dirty”DefDirty (see Saving a SetIDH_SaveSet).

Edit Menu

The Edit dropdown menu holds following commands:

· Undo CommandIDH_mnuEUndo
· Cut CommandIDH_mnuECut
· Copy CommandIDH_mnuECopy
· Paste CommandIDH_mnuEPaste
· Delete CommandIDH_mnuEDel
· Insert CommandIDH_mnuEIns
· Paste CommandIDH_mnuEPaste
· Paste from Istyle CommandIDH_mnuEIStyle
· Erase Bank CommandIDH_mnuEClear
· Import CommandIDH_mnuEImport
· Details CommandIDH_mnuEDetails
Depending on the displayed Subset and editing status, some commands are disabled (dimmed).

Undo Command

Most classical editing operations (Cut, Paste, Delete, Insert, Drag & Drop) can be undone, except when an Item Calls Change (i.e. redirection) CallsChange has been made (for example, if you have pasted a Program into F43 and replaced all calls to F43 with calls to G68, these replacements are irreversible, so the Paste operation that embeds them can’t be undone any more).

Cut Command

This command applies to Arrangements, Styles, Programs, Backing Sequences and Songs.

It saves the selected Item into the Clipboard and replaces it with an Empty ItemDefMptyItem.

If this Item is called by other Items, dialog opens to prompt the User for a decisionCallsChange. Depending on this decision, the command can or cannot be undoneIDH_mnuEUndo.

Copy Command

This command applies to Arrangements, Styles, Programs, Backing Sequences, Songs and KBD Sets.

It copies the selected Item into the Clipboard.

Paste Command

This command applies to Arrangements, Styles, Programs, Backing Sequences, Songs and KBD Sets.

It replaces the selected Item with the Item contained in the Clipboard.

If the overwritten Item is called by other Items, dialog opens to prompt the User for a decisionCallsChange. Depending on this decision, the command can or cannot be undoneIDH_mnuEUndo.

Note: After pasting an Item in a Set, Korg-i File Editor warns the User if the NameDefNam of this Item duplicates an existing one in the Set.

Delete Command

This command applies to Arrangements, Programs, Backing Sequences and Songs.

It saves the selected Item into the Clipboard and shifts all Items, which follow it in the BankDefBnk (or in the list) one position left. The last Item of the bank (list) becomes EmptyDefMptyItem.

If the deleted Item is called by other Items, dialog opens to prompt the User for a decisionCallsChange. Depending on this decision, the command can or cannot be undoneIDH_mnuEUndo.

Note: Styles cannot be deleted, because shifting a Style can, more often than not, produce memory overflow in the BlockDefBlk it enters.

Insert Command

This command applies to Arrangements, Programs, Backing Sequences and Songs.

It shifts all Items of the BankDefBnk (or the list) from the selected one to the last but one, one position right, then pastes the Item contained in the Clipboard into the vacant location. The last (lost) Item of the Bank (list) is saved into the Clipboard.

If this last Item is called by other Items, dialog opens to prompt the User for a decisionCallsChange. Depending on this decision, the command can or cannot be undoneIDH_mnuEUndo.

Note: Styles cannot be inserted, because shifting a Style can, more often than not, produce memory overflow in the BlockDefBlk it enters.

Paste from IStyle Command

This command applies to Arrangements, Styles and Programs.

This command allows loading into the currently selected cell an Item extracted from an IStyle fileDefIsf.

The Source file is selected via a standard Open File dialog. First the Item is copied into the Clipboard, then a standard PasteIDH_mnuEPaste command is internally issued.

Erase Bank Command

This command applies to all Subsets except Global and Arrangement GlobalDefSubSet.

It sets all Items of the selected User BankDefBnk to EmptyDefMptyItem.

Warning: Bank Erasing cannot be undone, and no synchronisationSpec can be attempted!

Import Command

This command applies to all Subsets except Global and Arrangement Global.

It replaces all the User BanksDefBnk of the selected Subset with homologous banks imported from another Set file.

Warning: Import commands cannot be undone, and no synchronisationSpec can be attempted when importing!

Details Command

This command applies to individual ArrangementsIDH_EditParArr, StylesIDH_EditParSty, Programs, Backing Sequences and Songs IDH_EditParPrg.

It opens a window that displays some parameters of the selected Item and allows some editing.

Note 1: Non-editable parameters are dimmed.

Note 2: Double-clicking the Item is equivalent to this command.

Options Menu

This menu gives access to various preferences:
- Highlight called Items checkbox: this concerns displaying Arrangement, Style and Programs grids. If checked, then a Red text means the Item is called by some other User Item(s), whereas a Blue text means it is nowhere.
- Duplicate name warning checkbox (see Editing Session ExampleStratEx note 1).
- Open last Set at Start-up checkbox (see Opening a SetIDH_OpenSet).

Window Menu

This menu provides standard commands concerning the arrangement of Sets windows on the screen:

· The Tile command arranges the windows vertically in order to display the maximum area of each window. On an XGA screen (1024x768 pixels), the Tile mode allows displaying 2 full Arrangements, Styles or Programs windows. This feature is especially useful for Drag & Drop operations between 2 different Sets.

· The Cascade command should be chosen if many Sets are currently open.

· The Arrange Icons command rearranges minimized windows icons at the bottom of the screen.

· A list of currently open windows allows activating any one.

Note: When quitting Korg-i File Editor, the current mode (Tile or Cascade) is memorized and retrieved at next start-up.

Utilities Menu

The Utilities dropdown menu holds following commands:

· Display Set Report CommandIDH_mnuURep
· Create Subset Report File CommandIDH_mnuUSSRep
· Update Preset Data CommandIDH_mnuUSwapPreset
· Export to Preset File CommandIDH_mnuUExPreset
· MIDI Setup CommandIDH_mnuUMidSetup
· Send to Korg-i CommandIDH_mnuUMidSend
· Send SysEx to File CommandIDH_mnuUSysex2File
Display Set Report Command

This command summarizes the ReferencesDefRef and NamesDefNam of all ItemsDefItem included in the current SetDefSet, as well as all CallsDefLink between Items.

The Report text can be edited on the screen, printed or saved as a plain text file.

Note: The Report window height is resizable.

Create Subset Report File Command

This command applies to Arrangements, Styles and Programs SubsetsDefSubSet. For KBD Sets, a similar function is available with a button.

It saves on disk a list of all User Items in the currently displayed Subset. Each Item line is composed of parameter fields separated by ”tab” characters, so that the file can be opened then edited, sorted etc. with a text processor, a spreadsheet program or a data base manager.

The saved fields are as follows.

· For Arrangements:
- Set Name
- Arrangement Reference, Name and Category
- Used Style Reference, Name and Category
- Program Reference and Name of each Arrangement Track.

· For Styles:
- Set Name
- Style Reference, Name and Category
- Program Reference and Name of each Style Track.

· For Programs:
- Set Name
- Program Reference, Name and Category.

· For KBD Sets:
- Split Point
- Program Reference and Name of each KBD Track.

Note: The Subset Report is neither displayed nor printed.

Caution: Subset Report File default extension is .XLS, so that double-clicking it automatically opens Excel® if present in the user’s system. You might prefer change for .TXT or .DOC in order to call for a text processor instead of a spreadsheet. On the other hand, a “Set reserved” extension like .ARR, .STY etc. would be an unwise choice, as you can imagine! If you want the Report filename to remind which Subset is concerned, you may include it into the name, not the extension; e.g. for FAVORITE.SET, Subset Report files could be named FavoriteArr.XLS, FavoriteSty.XLS etc.

Update Preset Data Command (i30 only)

By default, the names and categories of Arrangement Preset banks (A & B) displayed by Korg-i File Editor are Korg’s factory presets. They are stored in the i30prsts.txt file and loaded into the editor at start-up.

If the user has modified the Arrangement Preset banks on his or her i30, using its Swap arrangements command (OS versions 2.1 and up), the i30prsts.txt file should be updated accordingly, in order that Korg-i File Editor reflects correct preset names and categories.

This can be done easily with the Update Preset Data command, which simply copies Arrangement names and categories of C & D banks (supposed to match the new contents of i30 presets) into i30prsts.txt file. The previous version of i30prsts.txt is saved as i30prsts.bak before being changed.

Important note: Unlike the Swap arrangements operation on the i30, the Update Preset Data command does not affect the User Arrangements (banks C & D) of the current Set.

Export to Preset File Command (i30 and i40 only)

Warning 1: This command should be used by experienced Users only! 

Warning 2: You are advised not to change Program Banks A and B, nor the 1st Drumkit, as they are required for correct playing of General MIDI (GM) compliant MIDIfiles!

Since version 2.1, i30 OS (Operating System) provides a Load PRESET Data command in DISK Mode. A file named RESTORE.PRD, available from most KORG’s websites, holds the factory Preset Banks. This concerns only Arrangements (A, B) and Programs (A to E and Preset Drum Kits).

With Korg-i File Editor, you can build your own Arrangement and Program preset Banks by editing the existing RESTORE.PRD file, then restoring it to the i30.

Warning: the Items that called modified preset Items will have to be updated manually. For example, if exporting Program Presets replaced Breath Flute with Telephone2 at location D22, all Arrangements that call Program D22 will sound odd!

Let’s take an example: you want to replace the factory Preset Arrangement Bank B with the User Arrangement Bank D of MYNEWSET. Proceed as follows:

- Make a copy of RESTORE.PRD. Rename this copy, e.g. MYPRESET.PRD (i30 does not accept other extensions than .PRD).

- Within Korg-i File Editor, open MYNEWSET, then select Arrangement Bank D.

- In the Utilities menu, select the Export to Preset File command.

- Select destination Preset Bank B.

- In the file dialog, locate the MYPRESET.PRD file you want to modify, then double-click it.

- A prompt lets you change your mind.

- In addition, you can update the data displayed by the modified Preset grid.

- Outside Korg-i File Editor, copy the modified MYPRESET.PRD file to a floppy disk, then restore it into your i30 following Korg’s instructions (DISK Mode, Load PRESET Data command).

MIDI Setup Command (i30 and i40 only)

This command allows selecting a MIDI Driver to exchange data with the Korg-i via the TO HOST interface or a serial MIDI link.

Note: In order to use the TO HOST interface, a special driver is required. A 32 bit version of the KORG PC I/F MIDI Port driver is included in the setup files. It must be installed into the Windows\System directory using the New Hardware installation facility – see the InstallationInstall topic.

Send to Korg-i Command (i30 and i40 only)

This command uploads (sends) the current Subset to the Korg-i via the TO HOST interface or serial MIDI link.

Note 1: For Styles, only the current BlockDefBlk (i.e. the Block that holds the currently selected Style) is sent to the Korg-i.

Note 2: For Global and Arrangement Global, this function is accessed with specific buttons.

Send SysEx to File Command (i30 and i40 only)

This command saves the Subset data as a System Exclusive file (in Korg i-Series format). This file can be uploaded later to the Korg-i with an appropriate SysEx utility, or an equivalent function included in most sequencers.

Note 1: For Styles, only the current BlockDefBlk (i.e. the Block that holds the currently selected Style) is saved.

Note 2: For Global and Arrangement Global, this function is accessed with specific buttons.

Help Menu

· The Contents command accesses the table of contents of this Help file.

· The Tip of the Day command opens the corresponding window. The present and next tips are randomly chosen. If the check-box “Show tip at start-up” is checked, this window will appear when starting up Korg-i File Editor next time.

· The About Korg-i File Editor command opens a classical “About” dialog box.

FAQ

Why are some Items parameters editable with Korg-i File Editor and other are not?FAQ01
Can you cite 3 tasks that are impossible to achieve on the KORG i-Series itself?FAQ03
When I open a Set, the default window tab seems to be chosen on a random basis? FAQ04
What must I do when Korg-i File Editor warns me for duplicate Names? FAQ05
Why is the delay needed to display the Programs grid much longer than for Arrangements or Styles? FAQ06
What aren’t Delete and Insert commands available for Styles? FAQ07
Why is it impossible to select, delete, move etc. more than one Item at once?FAQ09
How can I use the Create Subset Report File command?FAQ11
How can I see a subset bank (e.g. Styles C) while editing another one (e.g. Arrangements D) in the same Set? FAQ12
Why are some Items parameters editable with Korg-i File Editor and other are not?

The general ideas behind these choices are as follows:

·  Korg-i File Editor is intended to help the User for tasks, which are difficult, cumbersome or even impossible to achieve on the Korg-i itself.

·  Conversely, editing operations that need an audio feedback would lack any interest if undertaken with a non-real time tool.

Can you cite 3 tasks that are impossible to achieve on the KORG i-Series itself?
1. Setting the keyboard Split Point of all Arrangements to F3 with a single command.

2. Replace all calls (in Arrangements, Styles etc.) to A15 Program with calls to F18.

3. Maintaining “synchronization” between relocated Items.

If, for example, you want to move Program Jazz Guitar 4 from F57 to F45 in I30PLOAD Set, Korg-i File Editor :

· shows the list of Items that call F57 and should be redirected to F45;

· performs all these redirections automatically;

· shows the list of Items that call F45 and should perhaps be redirected to another or other existing programs.

· In addition, you can print a Report of the present state of the whole Set (Names of all Items and mutual links between them).

None of these functions are available on the Korg-i.

When I open a Set, the default window tab seems to be chosen on a random basis?

No! When the Set window opens, the default tab is selected according to the last Mode used.

For example, if your previous active Set window was in Global Mode (i.e. Global tab was selected), the new window will open in Global Mode.

When you quit Korg-i File Editor, the Mode used by your last closed window is memorized, so that it will be used for the first Set opening when you start-up Korg-i File Editor again.

What must I do when Korg-i File Editor warns me for duplicate Names?

If several Items have the same name and one of them is moved, links synchronization can’t be reliably maintained.

So, it is a good idea to change the offending Name(s) before editing any Bank in the current Set.

Why is the delay needed to display the Programs grid much longer than for Arrangements or Styles?

For each Item to display, Korg-i File Editor searches for all User Items that call it in order to highlight Items that are called. Now, in an i30:

· An Arrangement can be called by Backing Sequences, which implies 10 comparisons per Arrangement;

· A Style can be called by Arrangements (128 max) and Backing Sequences (10 max), which implies 138 comparisons per Style;

· A Program can be called by Arrangements (128 x 11 tracks), by Styles (48 x 6 tracks), by Backing Sequences (10 x 8 tracks), by Songs (10 x 16 tracks) and KBD Sets (64 x 5 tracks), which implies 2256 comparisons per Program!

On slow computers, this delay can turn out to be unacceptable.

In this case, you can uncheck the Highlight called Items checkbox in the Options menu.

This will only affect the displayed grid, not the other functions of Korg-i File Editor.

Why aren’t Delete and Insert commands available for Styles?

Deleting or Inserting an Item implies shifting left or right all Items situated at its right in the current Bank.

But shifting Styles is, more often than not, impossible because a “big” Style that crosses a Block boundary can produce memory overflow in the Block it enters (remember that a Block size can’t exceed 15200 Events - see KORG’s Manuals)..

Why is it impossible to select, delete, move etc. more than one Item at once?

Because managing “links synchronization”, which is a major feature of Korg-i File Editor, would be almost impossible for the user, if not for the computer!

How can I use the Create Subset Report File commands?

The output of these commands is a text file with tab field separators inside each item line.

You can open the file with a text processor, but correct columns alignment will need adjusting tab marks. On the other hand, if you keep the default extension .XLS in the Saving dialog, double-clicking the file will open it with Excel® if you own it. So you’ll be able to change column widths, fonts, colors, delete or move columns, sort items by any field, merge data coming from other reports, print selected parts etc.

How can I display a subset bank (e.g. Styles C) while editing another one (e.g. Arrangements D) in the same Set?

Try this: duplicate the Set with a different name (with the Save As command) and open both Sets. Now, for example, you can select the Styles Bank C on the original and the Arrangements Bank D on the copy.

SUGGESTIONS / BUG REPORTS / QUESTIONS

Please E-mail the author Alain Fraysse at  afraysse@club-internet.fr
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Please read carefully the attached file LICENSE.DOC.
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Interactive Music Workstation.

An Arrangement defines all the elements needed to produce a song on the basis of a Style: Tempo, Program (sound) used by each track, volumes, panning and effect balances, etc.

A Style defines the accompaniment sequences (score) triggered by the chords played.

A Program defines the sound (timbre) of an instrument.

A Backing Sequence stores a sequence of played chords, along with all configuration parameters of the Korg-i (Arrangement and Style used etc.).

A Song is either a MIDIFile (all i-Series families), or a MIDI sequence stored in a KORG specific format (i3 and i30 families).

A KBD Set stores Keyboard assignments and most i30 or i40 Command Panel buttons status.

Global data are parameters handled in the Global Mode.

Arrangement Global data are parameters that apply to all the Arrangements (i30 and i40 families).

An Item designates an Arrangement, a Style, a Program, a Backing Sequence, a Song or a KBD Set.

An Empty Item is an Item without Name and with parameters set to default values (see KORG’s Manuals).

For Items with variable length (Styles, Backing Sequences, Songs), the Sequence Data Segment is empty.

A Block is a group of 4 Styles. A Block cannot take up more than 15200 Style Events (i.e. 60800 bytes).

A Bank is a group of Items of a given type. For example, the i30 holds 3 Styles Banks: Preset Banks A and B hold 64 non-modifiable Styles each, while User Bank C holds 48 modifiable Styles.

An Event is the smallest element that can occur in a musical sequence: a new note, a control change, a pitch bend etc.

Each Event descriptor takes up 4 bytes in i30 memory.

A Sequence is a musical pattern.

i-Series Subsets that contain Sequences are Styles, Backing Sequences and (i3 and i30 families) Songs. In files associated with these Subsets, all sequences are stored in the Sequence Data Segment, the length of which is variable, as opposed to the Control Data Segment, which holds the control parameters and has fixed length. Korg-i File Editor cannot edit nor analyze sequences.

A Reference is KORG’s code to locate an Item in the instrument memory.

Examples: A11, R47, BSeq 3

Links: mutual calls between Arrangements, Styles, Programs, Backing Sequences, Songs and KBD Sets.

For example, in I30PLOAD, Program D52 is called (used) by Style U12 and Arrangements A12, A14, A16 and A18.

Conversely, Style U12 is called by Arrangements A12 and A15, whereas it calls Programs A52, A86, C11, D52, Dr1 and Dr6.

Giving a unique Name to each Item, although not mandatory for the instrument to work, is required by Korg-i File Editor to correctly find relocated Items, detect duplicate Items etc.

A Set is a DOS directory, which contains files that share the same Generic Name but have respective extensions (suffixes) .ARR, .BSQ, .PCG, .SNG, .STY (i3 family), .ARG .ARR, .BSQ, .GBL, .KBS, .PRG, .STY (i40 family), .ARG, .ARK, .ARR, .BSQ, .GBL, .PRG, .SNG, .STY (i30 family).

According to KORG conventions, an i30 Set directory has same name as its files and extension .SET. Other families do not need holding the files in a single directory, and the name of this directory is free (but, for convenience, it could be a good idea to do so).

Each file stores a Subset of the Set: the Arrangements Subset, the Styles Subset etc.

For example (i30 family), the Set with Generic Name MYNEWSET is a directory named MYNEWSET.SET, which contains the following files: MYNEWSET.ARG, MYNEWSET.ARK, MYNEWSET.ARR, MYNEWSET.BSQ, MYNEWSET.GBL, MYNEWSET.PRG, MYNEWSET.SNG, and MYNEWSET.STY.

A Generic Name designates a file Set.

For example, the family Set with Generic Name MYNEWSET is a directory named MYNEWSET.SET that contains following files: MYNEWSET.ARG, MYNEWSET.ARK, MYNEWSET.ARR, MYNEWSET.BSQ, MYNEWSET.GBL, MYNEWSET.PRG, MYNEWSET.SNG, and MYNEWSET.STY. Korg-i File Editor cannot open a Set if these 8 files are not present in the Set directory. 

i40 family Sets must satisfy the same requirements, with .KBS extension instead of .ARK, but without any directory name constraint.

The same applies to i3 family Sets, except that they contain only 5 files with the same generic name and respective extensions .ARR, .BSQ, .PCG, .SNG, .STY.

An Empty Set named I3EMPTY (i3 family), I40EMPTY (i40 family) or I30EMPTY.SET (i30 family), acts as a template used by Korg-i File Editor for creating new Sets. It must be present in the same directory as Korg-i File Editor.

Note 1: Users should never have to open this Set, but its files can be copied, pasted then renamed into incomplete sets in order to complete them, for example. In most cases, using the Import function is a better and simpler solution.

Note 2: (i30 family) I30EMPTY.STY holds 48 Initialized StylesDefIniSty.

Note 3: Empty Set files are write-protected.

The Destination Set is the Set being currently edited, i.e. modified.

A Subset is a set of Items stored in one of the Set files: the Arrangements Subset, the Styles Subset, the Globals subset etc..

A Report summarizes the References and Names of all items included in a Set, as well as the links (i.e. mutual calls) between them.

It can be edited on the screen, printed or saved as a text file.

A Source Set is a Set that the User picks Items from before pasting them into the Destination Set.

A Librarian is a tool that allows configuring the contents of Items Banks loadable into an electronic music instrument, as opposed to an Editor, which allows modify the behavior of individual Items.

To Drag & Drop an Item, Click it with Left Button, Drag it while maintaining this Button pressed and release the Button when the Cursor is above the Destination Item.

Dirty Set data are data that have been modified since opening the Set.

Dirty files: files associated with dirty data.

Programs called shows a list of Programs that are called by the current Item Tracks.

Each Track can be redirected to another Program: double-click it, so you can select, either by Bank or by Category, a substitute for its present Program.

Style called shows the reference and name of the Style called by the current Backing Sequence or Arrangement.

This Style can be changed: double-click it, so you can select, either by Bank or by Category, a substitute.

Arrangement called shows the reference and name of the Arrangement called by the current Backing Sequence.

This Arrangement can be changed: double-click it, so you can select, either by Bank or by Category, a substitute.

An .ISF file holds one Style. An .IAF file holds one Arrangement. An .IPF file holds one Program. An .IDK file holds one DrumKit.

Their format is independent of the target i-Series instrument. It has been created by Milan Markovic as a “Greatest Common Divisor” for easier Item conversion and management with his IStyle program.

An Initialized Style is empty (i.e. has no sequence data), and its control parameters have standard default values as defined in KORG’s manuals.

